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1.0 HVPS Pre-Processing

Processing HVPS data first requires the Spec2D Executable, written in C++ and
Visual Basic and referred to as Playback. After some initial processing with
Playback, the main processing and display of HVPS data is accomplished via
HVPSview, an IDL-based program.

After a data file has been recorded, the first step to analyzing the data is to open the
Executable program, which is the same program used to record the data file. Make
sure that HVPS Mode is enabled, and that_150 microns per slice is set in the Display

window. Click on the folder icon ‘4. It will prompt you to open a
‘baseY YMMDDHHMMSS.HVPS’, which is a raw data file. It is binary and the
images are compressed. Once a file is chosen, a time period selector box will be
displayed.

Select Playback Period
—Data range of: base0802011613202D5 — ~ File Splitting
Start Date/Time: \ 02-01-2006 / 16:13:26.625 ] Enable File
End Date/Time: | 0z2-01-2006 / 19:28:5?.234] v Splitting
— Select Playback Range
i | Offset Particles / File
Start Time:| 02-01-2006 f 16:13:26.62Z5 |£J 0
1 600,000
End Time:| 02-01-2006 / 13:28:57.234 i 0
el
Start Playback Cancel Playback
Figure 1:

To select a time period, move the two sliders on the Start Time and End Time. For
an exact time period use the U and D buttons to increase and decrease time by one-
second intervals. To the right is the File Splitting option. HVPSview attempts to
keep information on each particle in memory. When the memory is full, the
program slows due to the use of virtual memory. This can result in unacceptably
slow processing. This can be remedied by enabling file splitting, which cuts the
original large data file into processed data files of manageable sizes, according to a
preset number of particles. A typical setting is 300,000 particles per file, but the
optimum size will depend on the attributes of the computer used.

Once the time period and file splitting options are chosen, click the ‘Start Playback’
button. A window will ask whether to create HVPSview pre-processed files, which
are called sorted files. These files are also binary with compressed images, but
various simplifications to the file structure have been made. For example, the data



is sorted into time sequence. A sorted data file is necessary to run HVPSview.
Playback also produces HK_BINYYMMDDHHMMSS.HVPS,
HK_TXTYYMMDDHHMMSS.HVPS, and PAIRSYYMMDDHHMMSS.HVPS
files. The first two contain probe housekeeping data in binary and ASCII forms
respectively. Thus, these files allow the user to obtain the housekeeping data
independently of HVPSview. The Pair file is now obsolete. Once you click ’yes’
you will return to the Main Display window.
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Playback allows the user to look at images while pre-processing the data. By
selecting the Maximum Playback RUN and choosing one of the two options,
Playback will create the HVPSview files as quickly as possible. This option is to
the right of the Help tab. The option to not display timestamps is fastest.

The other option is quite slow. To the right of the Folder icon there are four green
buttons. The farthest right is the Play button. This button will play the file back at a
speed set by clicking the icon to the right of the folder icon. You can use the Pause
button to stop playback. You can step through the data, particle by particle, using
the Step button.

On the Main Display, there is a Stereo Pair counter. This area will display

horizontal and vertical particles that arrived at nearly the same time. Clicking the
Settings button allows the user to set the detection settings:

1.1 Masked Diode Filling:



During data collection, a diode may become noisy. If the condition is serious
enough, the real time software will detect this and ignore (mask) the diode. This
results in a white line running the length of any particle image that includes the
mask diode. Examples are shown in Fig. 1 and Fig. 2. Playback has an option to fill
these lines within particle images. Click ‘tool’ then ‘mask bit replacement’, a
window entitled ‘Mask Bit Recovery settings’ appears. Enable mask filling here
and set the maximum number of consecutive masked diodes that can be filled.
Filling these artificial white lines is important for the measurement of area, which
also affects length when sizing corrections are used. It is even more important to
filled masked diodes when they are the edge diode, since that diode is used to
determine if an image is complete or not.
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i:igure 1: Example of the display used to enable masked diode filling.

1.2 Dead diode replacement

Similar to a noisy diode, a dead diode leaves a white line running through particle
images. In this case however the real time software cannot detect and mask the
diode. Therefore playback has an option to add a diode to the mask during pre-
processing. The dead diode must be identified first. This is accomplished via the
‘Pixel histogram analysis’ window (Fig. 3). The number of counts each diode has
had is displayed. Clicking in a numbered box turns it yellow and indicates that that
diode will be considered masked for the next time playback is run. That is, adding
diodes to the mask is a two step process. First, for the period being processed, you
must run playback, monitor the histogram of counts display and click on any diodes
that you want added to the mask. Next, exit and restart playback, the clicked boxes
remain yellow and this time they will be added to the mask for processing.



If a noisy diode is not detected and masked during data collection, it may be
detected during these same steps and also added to the mask. This can shorted the
time needed for HVPSview to process as it must also remove noisy diode effects.
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Figure 3: Example of the ‘Pixel histogram analysis’ window showing a couple dead
diodes (V-12 and V-117) and a detectable noisy diode (V-124).

2.0 HVPSview

2.1 HVPSview Installation
HVPSview runs on an IDL platform of 6.0 or higher. The projects programs should
be stored in a folder called HVPSview-version#. Please note that HVPSview has



been derived from the 2DSview software. The 2D-S has two input channels,
Horizontal and Vertical, while the HVPS has only one channel. For various reasons
stemming from both the hardware electronic configuration and the software, the
single HVPS channel has been called "Vertical* and "V", although the probe
usually is mounted horizontally. Please note that some example images below may
include a Horizontal channel, as the test data imaged better illustrated a concept,
such as masking. HVPS data will only show Vertical data.

To install the HVPSview software, follow these steps:

1. OpenIDL

2. Click File>Preferences—>Path and set the path to the HVPSview-version#
folder first and IDL default second. The window should look similar to the
one below. Make sure HVPSview is at the top of the search path.

Preferences

Figure 3

3. Click OK



4. In the command line at the bottom of the window type: @compileHVPS
—>Enter. (NOTE: IDL is not case sensitive, so it is OK to type
@compilehvps, and hvpsview.)

5. Type in the command line: HVPSview—> Enter. The following GUI
window will open up:

Al
File
‘EIE'lILl&I Cleanall W“DS | ™ UselnFocusOnly IArchiveﬁth\sﬁ\iq‘asci\ j IArchiveﬁth\sﬁnng j IMakaﬁNfaschhe\p d H
Status bar

Figure 4

2.2 More pre-processing

Before performing quantitative analysis some additional pre-processing steps must
be done. First .BIN files are needed:

1. Click the left folder icon [Z]. This Brings up a list of all the sorted files
created during the playback.

2. Select the SORTED file with the desired time interval.

3. Once the file is loaded a window displaying warning messages will pop up.
There may be messages regarding time inconsistencies found while
processing the sorted file. Usually there are no messages as the case shown
in Fig. 6.



Bl Messages generated while loading the sorted data - |I:I|£|

File

Array dimenzions must be greater than 0. :I
Idnable to display E:%00_data_for_testing_ver? 1 hsorted07 0806121344 154052 1540860000 _warr

.
1| | »

Figure 6: Example of a warming messages window.

Once a file is selected, a status bar in the lower left of the GUI window
shows the number of particles counted. The program will automatically
generate the files required. All the .BIN files are placed into a subdirectory
labeled, “data”. This process is only required one time for each sorted file.
The program automatically looks in the data subdirectory and uses the
appropriate .BIN file if it already exists from a previous running.

*Note: Due to file size, the time to create .BINS can be quite
extensive, but must be done for each SORTED file.

To continue, open a .BIN file:

1. Click the right Folder icon =1
2. Open the Data folder
3. Select a *.BIN for the desired time

Again additional files are created in the data subfolder if they do not already
exist. These are 1 Hz data files. There will be several pop-up windows
depicting the raw data, and the images are automatically saved in the data
folder. These auto-saved files are labeled: horiz*.png. Figure 7 is an
example of the type of window that will appear. The images can be viewed
at any point from this point forward. These are created primarily for SPEC
programmers to detect and debug idiosyncratic corrupted data problems.
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4. Again a warning messages window pops up showing warnings of
idiosyncratic data events. This window is rarely empty but usually has
several to a few dozen events. An example is shown in Fig. 8.

##il| Messages generated while loading the daka file - |EI|E|
File

wfarning | W:there ane 138 teqland area gt 0.0 | -
Index and 3 Area : 1 -104.0 40 40

Index and 3 Mglice: 1 0o 20 20

Index and 3 Ticks 1 1682219836 16822199339 1682220518

-
4 F

Figure 8: Example of th(;warning messages window that pops up after loading
the bin files.

Once this is completed, three time series are displayed for concentration,
extinction, and ice water content. If the file contains more than 300 seconds,
the data is coarsely binned into 300 segments for quick look, using the 1 Hz
data file that was generated upon opening the .BIN file. If the file is less
than 300 seconds then the 1 Hz data is used directly. These 1 Hz data are



for quick look only. The processing uses a crude length parameter (L1, see
appendix A) and no artifact rejection.
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By default, the horizontal array time series are displayed. The arrays can be
switched by clicking on the || (vertical) or || (horizontal) icons located on
the upper toolbar.

2.3 Viewing Images
To view the particle images before artifact rejection has been applied:
1. Choose the desired array either vertical or horizontal
2. Move the cursor over any one of the three plots near the time you want to
view
3. Single click, a window similar to Figure 10 will open.
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The arrows are used for changing the time interval. The single arrow icons _*/
allow for moving the view one strip at a time. The icons with two arrows 2] fast
forward and rewind. The drop down list to the left of the arrows controls the
length of time each strip is in the window while fast forwarding and rewinding.
Placing the cursor over single particles displays the size and other parameters in the
lower left hand corner. An enlarged image of the particle is displayed, as shown in
Figure 10.

2.4 Artifact Removal

The .BIN files contain all the data captured by the HVPS Probe. This includes:
noise, splashed, and shattered events, as well as valid images. The program has the
ability to remove unwanted data. Using the cleaning functions creates concentrated
data for the time series and particle size distribution plots. Before quantitative
analysis, there are two options for data filtering:

Clean all: Removes noise, shattering, and splashing.
Clean noise: Removes noise only.

To use the cleaning functions:
1. Specify the type of cleaning by clicking the corresponding icon on the
toolbar.
2. A text box will ask for an aspect ratio, as shown in figurell. If the cloud is
known to be liquid enter in 2.0. If the cloud is known to be ice enter a larger
value.
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Figure 8

If a cleaning method is not selected, all the images will be used. The resultant data
is automatically saved in the directory. If a cleaning function is selected, the
program searches for previous cleanings made for each .BIN file. If one is found,
you will be prompted with the window shown in Figure 12. If the aspect ratio is the
same, select yes. In doing so, the computer will not have to re-clean the data.

Question 5

v A Previous *autoCleanl . kxt file with Aspect_ratio and Cleanl Or cleand header lines are:
»._"/ 2,000 is_the_aspect_Ratio_for_roundness_definkion
Clean_All_or_Keep_SPlash_option: Al
IJse it ko load the cleaned resulk #

Figure 9

*Note: The program processes each particle individually based on statistics
of many surrounding particles; processing large files can take days.

The In Focus Only feature allows for further data filtering. This removes
the particles with holes in them. If the area of the hole is greater than the
specified size, the particle is eliminated from the data. For example, if 0.9 is
the selected criteria, then only those images with holes having less than 10%
of the total area will be used in the process.

To use the In Focus Only Feature:
1) Check the box to the left of “Use In Focus Only” on the
toolbar.
2.) Select a value from the drop down list (0.9, 0.8, 0.70).

2.5 Time Series and Particle Size Distribution (PSD) Plots

2.5.1 Zooming into a time interval
1.) Click on the magnifying glass icon _%



2.) Click one of the three time series near the desired start time for analysis.
3.) Click the desired end time for analysis.

This creates a smaller time interval to be examined. Choosing small time
periods significantly reduces subsequent processing time. Similar to the
previous window, this new window initially displays concentration, extinction,
and ice water content, read from the 1 Hz data file described above, on single
time series plots (both H and V are shown simultaneously here). Figure 13
shows the zoomed-in data window.
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PSDs are plotted as well. To view them, click on the Particle Size Dist. Plots tab.
These are also crude quick look products using 1Hz data files. The zoomed-in data
window allows for a much more in-depth data analysis.

In order to access these options select Hi-Res, and click UPDATE.

The start and end times can be changed by typing new time values in the Stime and
Etime boxes and clicking the UPDATE button.

Hi-Res




To save any time series or PSD plot as an image, click the Save.png button in the
droplist. To save the plot as an ASCII file, click the Save.Ascii button. To print a
plot, click the Print button.

The “ST” button on the left is for displaying stereo images, which is currently not
used.

The “HK” is for displaying the Housekeeping data. Figure 14 is an example of the
plots obtained by selecting HK. This data is used primarily by SPEC Inc. It can
also be used for troubleshooting.

il HKzoomed:15:43:08.000.000.000 to 15:43:28.000.000.000 alglil

Help Motes | save_corfia | load_config | sawe_png | Print | save_ascii | Reset | Update | ¢ Al & Zoom
z070BOE121344_154254_154348. 0000.bin_ HK: dT= 520s 15:43:08.000.000.000-15:43:28.000.0 -
- — snnel 1: default: H.dinde
% E 3 Tracel: [Hdioded =
£zt w
7 o'E E
T 22E = hace? [Hoiodebd =
4 E =
G R0 = . -
£ E 3 Trace3: |Hdiode127
ZeE —
R == =
2 E E
T 14
TI54308  154X10 154313 154315 154R128  154%20 154323 154325 15:43:28
- time (T:blue=Hdiode(¥) Zired=Hdiodet4(V} JiBlack=Hdioded 27 ()}
Ty — Pannel 2: default: V. diode
z 0C B
s L ] Tracet: [vdiodell =
ol =
% E Trace2: |VdindeE4 B
% ]
200 E Traced [Vdiode127 ¥
2 7
TS5 -
3
154308 154310 154313 154315 154318 154320 154323 154325 15:4308
time (Tiblue=YdiodeD(Y) Zred=vdiodet4(V} 3:Black=Vdiodel27(V))
= E 5
E T B Fanrel 2: default: Tas Press
% 7000 - E
e jd | Tracel: [tas =2
2 1500 —
g E ] Tracez: [VertlLaseD) =
5 E E
H = =
é ‘OGO: 3 Trace3: [HorizLasesD ™
£ so0 =
» E E
] = |
154F08 154310 1S4X13 154315 154F18 154320 154323 154R25 15:4%28
time (1:blue=tas(m/s) 2:red=YertLozerD(Y} J:Black=HorlzLaserD{V}}

Figure 11

*Note: Click update after changing any options in the zoomed data window.
5.5.2 Comparing time series

Use the CompTMS button to compare time series parameters. In this window,
different sizing methods, arrays, and parameters can be plotted and compared.
Sizing methods are described in Appendix A. ASCII and image files can be saved
from this window.
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2.5.3 Comparing size distributions

Use the CompPSD button to compare particle size distributions. In this window,
different sizing methods, arrays, and parameters can be chosen, plotted and
compare. Sizing methods are described in Appendix A. Furthermore, average
values of counts, concentration, extinction and ice water content will be plotted
when applicable.
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2.5.4  Viewing the HVPS images from a selected time interval
1.) In the zoomed data window (Figure 13), check the box to the left of ‘Filter’
if accepted images only are desired (for both display and processing).
Unclick the filter box to process and display using all the images accepted
and rejected. Rejected images will be highlighted with a yellow
background.
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button.
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If the filter box is not checked, images will be displayed including: accepted
particles, noise, splashes, and shatters. The rejected images are red and are
highlighted in yellow as shown in figure 18.
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This window has the same functionality as described in section 2.3. Clicking

| Generate_images_png_pages

I will cause pages of images to be
displayed on the computer screen saved to the data/png directory. Buttons “cleaning
by Start-end clicks” and “label one image as bad with one click” are for
manually removing bad images or noise if the auto-cleaning method doesn’t do a
perfect job.

The “Timeshift”, “fishing” and “De spur” are special buttons used inside SPEC
INC. We use them to look at the laser beam alignment. We also use them to look at
the cloud particle special cluster distribution and to study the noise image
distribution in the initial stage of the software. They are for development and
automatic removal of noise, splashes and shattering. You do not need to use them.

2.5.5 Boolean Filtering
The Boolean feature allows for further sub setting of data. It is possible to filter out

particles based on size, location, and various other parameters. To use Boolean
filtering:




1) From the zoomed data window select Boolean On as

shown:
2.) Specify the filtering parameter from the drop down list
3.) Use Boolean logic from the drop down list to add filter conditions.
4.) If using numerical values, insert a space between the logic and numerical
value.
5.) Hit UPDATE

The IDL syntax for the Boolean symbols is defined below:
And-And

Or-Or

Not-Not

Eg-Equal to

Ne-Not equal to

Ge-Greater than or equal to
Gt-Greater than

Le-Less than or equal to
Lt-Less than

*-Multiply

+-Addition

--Subtraction

()- Used for order of operations

For example, if user types “ L1n gt 10” are entered, the filter box is checked and the
Update button is clicked, only those accepted and rejected particles with size “L1n
greater than 10 pixels” will be selected and displayed in the H-strip and V-strip
fields. These will also be used to make the time series and PSD plots. Figure 19
shows an example of when “L1n gt 10” was input for updated processing:
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Another way to filter the data in a very specific way is to use what has been named
the in-focus only option. To access this, go back to the first main HVPSview
window and click the ‘use in focus only’ check box. You must also select a value
from the drop down list. Value options are 0.9, 0.8, and 0.7. This filters the data to
use only those images that are at least 90% (80 or 70) shaded. This could be
accomplished via the Boolean option as well. The difference is that when using the
check box, the sample volume is adjusted using depth of Field values for in-focus
particles.

3. HVPS data Batch processing (Archiving)

As described in playback processing section 1.0, after many split sorted files are
generated the data can be processed in batch mode, allowing the computer to run
over night. When processing batches, all the SORTED files are converted to .BINS
and an All Clean filter is applied to them. This allows large quantities of data to be
processed and filtered for use at a later date.

The batch processing can be done in Liquid mode or Ice mode. When the user
knows if the 2-DS probe is flying through liquid cloud (by looking at the
temperature, or by observing the playback image types), the batch processing
should be done in Liquid mode. When the probe is flying in the ice cloud, the user
should use Ice mode.



3.1 Liquid mode Batch processing

3.1.1 Archiving ASCII Files

1.) Copy all sorted***.HVPS and the associated HK_bin*.HVPS,
HK_TXT.HVPS and Log_TXT*.HVPS files into the same directory.

2.) Get IDL started and follow the steps described in section 1.1.1?

3.) The initial GUI screen will appear. Select “archive multi Liq ascii ” from
the drop down list. A dialog window will appear for the user to select an
input file of type Sorted*.HVPS, as displayed in Figure 20. Navigate to the
directory containing the SORTED*.HVPS data that requires processing.
Click on one of the sorted files, and then click “open” on the lower right
corner. That “please select a file” window will disappear.
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down list with
Archive option

4.) Return to the IDL front screen. All of the files for overnight processing will

be displayed.

5.) If all the files are present, type y > Enter in the IDL command line. This
computer process all the sorted data files in the selected

will make the

directory.




******** Here ae all Sorted 205 data files which are ==
=* faund in current directany for overnight processing =

C:Mantlan_June_1_20090SORTEDOS1031123842_123842 123923 0000.2D5
C:Mantlan_June_1_2009%S0RTEDOS1031123842_123921_123341_0001.2D05
CiMartlan_June_1_2009S0ORTEDOS1031123842_123333 124004_0002.2D05
C:Mantlan_June_1_200SORTEDOS1031123542_124002_124022_0003.203
C:Mantlan_June_1_20090S0ORTEDOS1031123842_124020 124043 0004.205
CiMartlan_June_1_200%5S0RTEDOS1031123842_124047_124110_0005.2D05
CiMlartlan_June_1_2009S0ORTEDOS1031123342_124108_124132_0006.2D5
C:ilantlan_June_1_200SORTEDOS1031123842_124130_124156_0007.2D3
C:Mantlan_June_1_2009%S0RTEDOS1031123842_124154 124223 0008.2D05
C:Martslan_June_1_200W5S0RTEDOS1031123842_124221_124246_0003.205
C:Mlantlan_June_1_200TSORTEDOS1031123542_124244 124307_0M0.203
C:Mantlan_June_1_20090SORTEDOS1031123842_124305 125343 0011.2D5
CiMartlan_June_1_2009%50RTEDOS1031123842_125341_130003_ 002205

CiMartlan_June_1_2009S0RTEDOS1031123842_130001_0013.2DS

Are you sure to do above files ? yes/no

Enter yar n:
Mame Type
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Ready
Figure 21

The sorted files will be processed one at a time in order. Some initial plots and
warning messages will pop up, be saved, and deleted. The original GUI screen will
remain open and the progress is displayed in the status bar. The IDL standard
output screen will also display some steps that the archiving process has reached.
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The status bar in Figure 22 displays the following information: 1) The V-channel
automatic noise removal is being used. 2) Of the 828565 images, it has examined
115000 particles. 3) The end of the third loop noise removal process for the H
channel was done at time: Wed Jun 10, 12:52:04 2009; and etc.



As each SORTED**.HVPS file is processed, many files are generated and saved in
sub-directories labeled datal, data2, data3, etc. in the directory where the original
SORTED***.HVPS files are stored. These files are initial plots of the file and
warning messages encountered when loading the data file, the auto-clean results
and the horiz***.bin and vert**.bin files. The most important two files are
H_archive_ HVPS**** xxxx_Ns.txt and V_archive_ HVPS**** xxxx_Ns.txt.
They are located in the subdirectory png under the datal, data2, data3 and etc.
These two files contain the 1Hz concentration, extinction, ice water content, time
series and particle size distributions. The header lines contain the detail data format
of the archive file.

3.1.2 Archiving Images

After H_archive_ HVPS ***Ns.txt and V_archive_HVPS ***Ns.txt 1Hz archive
files are generated for each sorted***.HVPS file, the HVPSview software can be
used on the data. To archive the images:

1)) Select “Archive Multi Liq png” from the .png drop down list (see Figure
20).

2.) A window will ask how many images per second to archive. This is
dependent upon cloud type and computing power. Type the desired number
of images per second and press Enter. Only the first images up to that
number will be archived each second.

The images are saved in the subdirectory png under the corresponding datal, data2,
data3 etc. subdirectory.

3.1.3 Combining the archived liquid ascii files

To combine all the smaller archive files into a single data file for the whole flight, a
separate IDL program is used. To combine all ascii files follow these steps:
1.) Copy all H_archive_ HVPS** Ns.txt into one folder or directory.
2.) Start IDL
3.) Click File-> Open-> (Find
HVPSview_ver#)—>combine_Lig_Ns_archive_61bins_HorV.pro
4.) Click Run > Compile combine_Lig_Ns_archive_61bins_HorV.pro
(Ctrl+F5)
5.) Click Run = Run combine_Liq_Ns_archive _61bins_HorV.pro (F5)
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6.) You will be prompted to select H or V. This determines whether it is the
horizontal or vertical files being combined.

7.) Go to the directory containing the files> and select a file.

8.) In the IDL command line type y—>Enter

From then on, all the H_archive_ HVPS_ *** Ns.txt files will be read and combined
in a single archive file, saved in the same directory as the smaller archive files.

3.1.4 Additional Notes

To batch archive with the clean option of removing noise only, you should click the
“archive_multi_Liq_ascii WS” button instead of the “archive multi Liq ascii”
button and follow the same instructions above.

To do batch archiving without doing any removal of noise, click the
“archive_multi_Liq_ascii NC” button instead of the “archive multi Liq ascii”
button and follow the same instructions above.

Clicking the “ Archive this liq ascii” or “archive this Liq png” in the initial
zoomed window will archive the current loaded data file in whatever cleaning state
the data is in. If it is cleaned already, it will archive it using only the accepted
images. If it is not cleaned, it will use all of the images to do the archive etc.

The “make multi_pbyp asciis” is a spare button for future use and it currently has
no functionality.

Clicking any of the “ Make N ascii_Liq”, “Make N ascii_ice”,
“Make N ascii_Liqg WS”, “Make N ascii_ice WS”, “Make N ascii NC” will
batch-generate many zoomed***.txt ascii files that contain information about each



particle in each line for users to do their own data processing and analysis, if they
choose to.

3.2 Ice mode Batch processing

3.2.1 Archiving Ice ASCII Files

1. Copy all sorted***.HVPS and the associated HK_bin*.HVPS,
HK_TXT.HVPS and Log_TXT*.HVPS files into the same directory.

2. Get IDL started and follow the steps described in section 1.1.1

3. The initial GUI screen will appear. Select “archive multi Ice ascii ” from
the drop down list. A dialog window will appear for the user to select an
input file of type Sorted*.HVPS as displayed in Figure 20. Navigate to the
directory containing the SORTED*.HVPS requiring processing. Click on
one of the sorted files, and then click “open” on the lower right corner. That
“please select a file” window will disappear.
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4. A pop up window with the ice archiving options is shown in Figure 25. See
Appendix A for a description of the options.
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Figure 25




5. Click Accept

6. Return to the IDL front screen. All of the files for overnight processing will
be displayed.

7. If all the files are present, type y = Enter in the IDL command line. This
will make the computer process all the sorted data files in the selected
directory.

““““““““ Here are all Sorted” 205 data files which are =
= found in current directory for overnight processing =

C:Martlan_June_1_200W5S0RTEDOS1031123842_123342_123323 0000.205
C:Mlantlan_June_1_200SORTEDOS1031123842_123321_123341_0001.2D03
C:Mantlan_June_1_20090\SORTEDOS1031123842_123933 124004 0002.2D5
CiMartlan_June_1_2009%5S0RTEDOS1031123842_124002_124022_0003.205
CiMartlan_June_1_2009S0RTEDOS1031123342_124020_124043_0004.2D5
C:Mlantlan_June_1_200SORTEDOS1031123342_124047_124110_0002.2D03
C:Mantlan_June_1_20090S0ORTEDOS1031123842_124108_124132_0006.205
CiMartlan_June_1_2009%5S0RTEDOS1031123842_124130_124156_0007 205
CiMartlan_June_1_2003S0ORTEDOS1031123542_124154 124223 0008205
C:Mantlan_June_1_20090SORTEDOS1031123842_124221_124246_0009.2D5
C:Mantlan_June_1_20090S0RTEDOS1031123842_124244 124307_0M0.205
CiMartlan_June_1_2009S0RTEDOS1031123842_124305_125343 0011205
C:Mlantlan_June_1_200SORTEDOS1031123842_125341_130003_0M 2203

C:Mantlan_June_1_20090\S0ORTEDOS1031123842_130001_0013.2DS
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The sorted files will be processed one at a time in order. Some initial
plots and warning messages will pop up, be saved, and deleted. The
original GUI screen will remain open where the progress is displayed
in the status bar. The IDL standard output screen will also print out
some of the steps the archiving the process has reached.
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The status bar in figure 27 gives the following information: 1) The V-
channel automatic noise removal is being used. 2) Of the 828565 images, it
has examined 115000 particles. 3) The end of the third loop noise removal
process for the H channel was done at time: Wed Jun 10, 12:52:04 2009.

As each SORTED**.HVPS file is processed, many files are generated and
saved in a sub-directory labeled datal, data2, data3, etc. in the directory
where the original SORTED*** HVPS files are stored. These files are
initial plots of the file, warning messages encountered when loading the data
file, the auto-clean results and the horiz***.bin and vert**.bin files. The
most important two files are H_archive HVPS**** xxxx_Ns.txt and
V_archive_ HVPS**** xxxx_Ns.txt. They are located in the subdirectory
png under the datal, data2, data3 and etc. These two files contain the 1Hz
concentration, extinction, ice water content, times series and particle size
distributions. The header lines contain the detail data format of the archived
file.

3.2.2 Archiving Images

After H_archive_ HVPS ***Ns.txt and V_archive HVPS ***Ns.txt 1Hz
archive files are generated for each sorted***.HVPS file, the HVPSview
software can be used on the data. To archive the images:
1. Select “Archive Multi_Ice png” from the .png drop down list (see
Figure 20).
2. A window will ask how many images per second to archive. This is
dependent upon cloud type and computing power. Type in the
desired number of images per second and press Enter.

The images are saved in the subdirectory .png under the corresponding
datal, data2, data3 etc subdirectory.



3.2.3 Combining the archived Ice ascii files

To combine all the smaller archive files into a single data file for the whole
flight, a separate IDL program is used. To combine all ascii files follow
these steps:
Copy all H_archive_ HVPS**_Ns.txt into one folder or directory.

1.
2.
3.

Start IDL

ClickFile>Open—-> (FindHVPSview_ver#)->combine_archive_TC4

Steve_gains_of 61bins_HorV.pro.

4. E:IickRun%CompiIecombine_archive_TC4_Steve_gains_of_61bins

5.

_HorV.pro. (Ctrl+F5)
Click Run >Run

combine_archive_TC4_Steve_gains_of 61bins_HorV.pro. (F5)
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Step 4

Step 5

6. A prompt you to select H or V, this determines whether it is the
horizontal or vertical files being combined.

7. Go to the directory containing the files—>

8. Inthe IDL command line type y—>Enter

select a file.

From then on, all the H_archive_ HVPS_*** Ns.txt files will be read and
combined in a single archive file, saved in the same directory as the smaller
archive files.

3.2.4 Additional Notes

To batch archiving with the clean option of removing noise only,
you should click the “archive multi Ice ascii. WS” button instead
of the “archive multi Ice ascii” button and follow the same

instructions as above.




To do batch archiving without removing noise, you should click the
“archive_multi_Ice ascii NC” button instead of the
“archive multi_Ice ascii” button and follow the same instructions
above.

Clicking the “ Archive this Ice ascii” or “archive this Ice png” in
the initial zoomed window will archive the current loaded data file in
whatever cleaning state the data is in. If it is cleaned already, it will
archive it using only the accepted images. If it is not cleaned, it will
use all images to do the archive, etc.

The “make multi_pbyp_asciis” is a spare button for future use and
it currently has no function.

Clicking any of the “ Make N ascii_Liq”, “Make N ascii_ice”, *
Make N ascii_ Lig WS”, “Make N ascii_ice WS”, “
Make N ascii NC” will batch generate many zoomed***.txt ascii
files that contain information of each particle, in each line for users
to do their own data processing and analysis, if they choose to.



Appendix A: Derived Parameters, Methods, Equations in
HVPSView

}— I-1_i

Derived parameters are as follows: ‘Timestamp’, ‘Index’ of same event’s image
in the sorted file, ‘A;” = number of shaded pixels, ‘L1’ = number of pixels in TAS
direction that the event lasted for, ‘L,” = number of shaded pixels in array direction
for the slice during the event for which the number of shaded pixels is maximized,
‘L3’ = the diameter of the circle that just circumscribes the shaded event pixels. 'Ly’
= similar to ‘L,’ except it is the total number of pixels between the shaded end
pixels instead of just the shaded pixels. 'Ls' = is similar to 'L4' except it is the
distance between the extreme shaded end pixels from all the slices whereas for 'L’
it is the end pixels in a given slice. See Figure 1. Az = (n/4)Ls% F1’ = 0 if neither
edge was shaded, 1 if left edge only was shaded, 2 if right edge only was shaded, 3
if both edges were shaded (for any slice during the event), ‘Adj;’ = adjustment
factor #1 (defined below), ‘Adj,’ = adjustment factor #n (defined further below),
‘PCy’ = position of particle center on array, determined as the center between the
extreme edge points of the slice that determined L,. ‘PCs’ = the position of the
center of the circumscribing circle. ‘PC4’ = position of particle center on array,
determined as the center between the extreme edge points that determined Ls. For
logistic reasons, the derived files will also have TAS included. Lg = the number of
white pixels in the strip(s) that defined L4. So L4 is the strip for which the end




shaded pixels are farthest apart which can be a surrogate for the outer diameter of
an out of focus ring. Lgthen is a surrogate for the inner diameter of the ring as it is
the number of white pixels for the strip that defined L4. If there are two or more
strips for which L4 is maximized then let Lg be the maximum value for those strips.
L7 is the Alexei scheme corrected size as follows:

First of all use the maximum value of the two inside-perimeter area estimates. Next
we simply use the table at the end of Alexei’s report. For each image we have a
total area (A, = max of 2 inside perimeter area estimates, from Alexei’s Matlab
algorithm) and an image area (shaded pixels, also in Alexei’s code but we already
have this = A;). We take the square root of 1 minus the ratio of the later to the
former. We look up the closest value in the appropriate column of the table (that is
the Dspot/ Dmax column)(we are using table 40% shadow depth). We find the
corresponding value in the 2nd column (that is the Dmax/Do column). We take the
inverse of that and multiply by Dmax to obtain Do, which is our corrected size
estimate for the bead. If the corrected size (Do) is larger than the original size
(Dmax), do not use the correction! use Dmax instead. For round images Dmax
might be better estimated from total area but for the bead data we will have to use
the along the array size (L) as the bead's speeds through the probe varied (unless
TAS is well adjusted and speeds don’t vary too much).

Lg is just as Ly above except instead of Dmax = L4, Use D,,, = iA2 *% . (in both
VA

1
L; and Lg above we are using L4 instead of the possibly more logical Ls because of
the tilted arrays giving skewed images... Lgtries to account for elongated images
with the ratio L4: L;)

For both L7 and Lg above, L4 should be used for in-focus images at the 90% level.
I. E. after calculating L7 and Lg, replace their values with L,’s value for the subset
of data that is in-focus at the 90% or better level.

Adj; is calculated as follows:

. SV S
Adjl — defa%v1 — Adefault SAl

SV

actual

=TAS x At x SA, .

default

SV, =TASxAtxSA

| acual



SV stands for sampled volume (Liters), SA for sample area (mmz2), TAS (m/s) the
speed of air through the probe sample area, and At (seconds) the time period of the
measurement.

SAdefault = 128 X pXS X dww

Where ‘pxs’ =0.01 mm (10 um) is the optically realized size of the array elements
and dyw = 63 mm (6.3 cm) is the window to window distance. ‘Strbsz’ is the pixel
size in the TAS direction (strobe size) and should also = 10 um but could differ if
the aircraft flies too quickly or an incorrect TAS is sent to the probe during data
acquisition.

SA, _=(127 + L, xstrbsz/pxs) x pxs x min[d ,,,d ]

where dof stands for depth of field and
Aoy (mm) = (Fy; = 1,2 xstrbsz?(zm?) )/1000.

where Fgor = 5.13 (um™).

PC; can be found as the halfway point between the edge points of the image on the
array for the slice that defined L.

PC; can be found as the center of the circle that defined Ls.

Methods - Equations:

Method 1 (M1): (TAS direction, all particles): For each time bin (of size At),

Concentration (#/L) = K szd%V . Where K = unit conversion factor.

default

Counts time series: the number of particle events per time bin.

SV Where K = unit

default

Extinction (Km?) = 2xKx2 (Adj; x Areax pxs x strbsy

conversion factor.



; 3 (Adj, xmin[axAﬁ,pi%%x(Ll x strbsz)*])
IWC: (g/m’) = K, x 1 SV where A =
default

(Area x pxs X strbsz)/1000000, o = 0.115, B = 1.218, p,=0.917, and where K; and
K are unit conversion factors.

K x 3 (Adj, x % x (L, x strbsz)®) ) _ )
LWC: (g/m®) = 2. (A 6 4 . Where K3 is unit conversion
default

factor.

Counts PSD: For each size bin, the formula for bin height is simply the number of
particles in that size bin. Use size bins with width equal to strbsz for now. Bin (L; x
strbsz) into the size bins. The first size bin has events for which L; = 1 and the bin
edges are 0.5*strbsz and 1.5*strbsz, the n™ size bin has events for which L; = n and
(n - 0.5)*strbsz and (n + 0.5)*strbsz as bin edges....

Concentration PSD (#/L/um): For each size bin, the formula for bin height is
K XZ(Adj%in_Width(ﬂm) KV ) where the sum is over all events in that size bin

and Where K = unit conversion factor. Bin as above for counts PSD.

Area PSD (mm?%L/um): For each size bin, the formula for bin height is
K x> (Adj,) x A . . .
2. (Adi; Ain_wi dith(zm) x SV, where the sum is over all events in that size

bin and A=(Area X pxs X strbsz)/1000000 and Where K = unit conversion factor so
the units come out. Bin as above for counts PSD.

Ice Mass PSD (g/m®/um):

3" (Adj, x min[a x A”, p, Koz, (L, x strbsz)*])
K, x K, 6 A where
! (bin _ width(zm)XSV gegauir)

A=(Area X pxs X strbsz)/1000000, o = 0.115, f = 1.218, p, = 0.917, and where K;
and K, are unit conversion factors.

Liquid Mass PSD (g/m®/um):

K x 3 (Adj, X%X(Ll x strbsz)®) _ _
(bin_ width(zm) x SV, Where K = unit conversion

factor.



Method 2 (M2): (All in, along array): For each time bin (of size At),

Concentration (#/L) = KXZAd%V where
default

Adj, = Svdefa%vz = SAdefa%Az where SA, =(127-L,)x pxs xmin[d,,,,d, ,]

and Adj, = 0 if either edge pixel is shaded (F1 # 0). Where
dy; ,(mm) =(5.13(m-1) x L2 x pxsz(mz))/looo. and where K = unit conversion factor.

Counts time series: the number of particle events per time bin.

Extinction (Km) = 2 Kx 2 (Adi; x Area x pxs x S"bs%v where K = unit
default

conversion factor.

> (Adj, x min[a x A?, p; Kez x (L, x pxs)°])
IWC: (g/m®) = K, x Ky 6 4. Wwhere
default

A=(Area X pxs X strbsz)/1000000, o = 0.115, § = 1.218, p,=0.917, and K, and K;
are unit conversion factors.

K xS (Adj, X%X(L4 x pxs)®)

LWC (g/mS) = Svdefault

to make it so the units come out.

. Where K = whatever you have

Counts PSD: For each size bin, the formula for bin height is simply the number of
particles in that size bin. Use size bins with width equal to pxs for now. Bin (L, x
pxs) into the size bins. The first size bin has events for which L, =1 and the bin
edges are 0.5* pxs and 1.5* pxs, the n™ size bin has events for which L,=n and (n -
0.5)* pxs and (n + 0.5)* pxs as bin edges....

Concentration PSD (#/L/um): For each size bin, the formula for bin height is
Kx 2 (Adj,) . . .
2 %in_wi dith(zam) x SV where the sum is over all events in that size bin

and where K = unit conversion factor.



Area PSD (mm?/L/um): For each size bin, the formula for bin height is
Kx 2 (Adj,) X%)m_width(ﬂm) eV where the sum is over all events in that size

bin and A=(Area x pxs X strbsz)/1000000 and where K = unit conversion factor.
Bin as above for counts PSD.

Ice Mass PSD (g/m*/pm):

> (Adj, x min[a x A7, p; %% x (L, x pxs)°])
K, x : (bin _ width(um) x SV ) "WET

A=(Area x pxs X strbsz)/1000000, o. = 0.115, § = 1.218, p,=0.917, and K, and K;
are unit conversion factors.

Liquid Mass PSD (g/m*/um):

K><Z:(Adj2 ><£><(L4 x pxs)?) ] ]
6 (bin_ width(zm) x SV )where K = unit conversion
—_ default

factor.

Method 3 (M3): (All in, simple non-adjusted spheres): For each time bin (of size
K x ZAdj/
Svdefault Where

At), concentration

Adj, = SVdefa%V3 _ SAdefa% s Where

SA, = (127 - L) x min[pxs, strbsz] x min[d,,,,,d ]
and Adjs; = 0 if either edge pixel is shaded (F1 # 0). Where
dyr (mm) = (5.13(zm ) x (Ly)? x min[pxs, strbsz]® (zm?))/1000. and where K = unit

conversion factor. Reject events for which L4 gt 2.1*L1 or L4 It 0.49*L1 and area
gt 2.

Counts time series: Simply plot the number of accepted particle events per time
bin.

T .
o Z x K x 3 (Adj, x L3 x pxs x strbsz) ]
Extinction (Km™) = 2 2 (Al < ~ where K = unit
default

conversion factor. Rejects events for which L4 gt 2.1*L1 or L4 It 0.49*L1 and area
ot 2.



0.917 x K x Y" (Adj, x%x (L3 X A PXS X strbsz)a)

sV,

conversion factor. Reject events for which L4 gt 2.1*L1 or L4 It 0.49*L1 and area
gt 2.

where K = unit

efault

IWC: (g/m*) =

K x> (Adj; x % x (L3 X A/ PXS x strbsz)3)
sV,

conversion factor. Reject events for which L4 gt 2.1*L1 or L4 It 0.49*L1 and area
gt 2.

LWC: (g/m®) = Where K = unit

efault

Counts PSD: For each size bin, the formula for bin height is simply the number of
particles in that size bin. Use size bins with width equal to ./pxs xstrbsz for now.

Bin (L3 x /pxs xstrbsz) into the size bins. The first size bin has edges of 0.5*

Jpxs xstrbszand 1.5% /pxs x strbsz, the n™ size bin has (n - 0.5)* /pxs x strbszand (n
+ 0.5)* /pxs xstrbszas bin edges. Reject events for which L4 gt 2.1*L1 or L4 It
0.49*L1 and area gt 2.

Concentration PSD (#/L/um): For each size bin, the formula for bin height is
K XZ(AdJ%in_Width(ym)xSVdefaun) where the sum is over all events in that size bin

and where K = unit conversion factor. Bin as above for counts PSD. Reject events
for which L4 gt 2.1*L1 or L4 1t 0.49*L1 and area gt 2.

Area PSD (mm?%L/um): For each size bin, the formula for bin height is

%x K x> (Adj, x Lj x pxs x strbsz) )
(bin_ width(zm) x SVdefau“)where the sum is over all

events in that size bin and where K = unit conversion factor. Bin as above for
counts PSD. Reject events for which L4 gt 2.1*L1 or L4 It 0.49*L1 and area gt 2.

Ice Mass PSD (g/m®um): For each size bin, the formula for bin height is
0.917 x K x Y" (Adj, x%x (L3 X 4/ PXS x Strbsz)a)
(bin _ width(zm) x SV ()

conversion factor. Reject events for which L4 gt 2.1*L1 or L4 It 0.49*L1 and area
gt 2.

where K = unit

Liquid Mass PSD (g/m®/um):

K x> (Adj, x%x (L3 X A/ PXS X strbsz)g/

(bin_ width(zm) x SV,,,) Were K = unit



conversion factor. Reject events for which L4 gt 2.1*L1 or L4 1t 0.49*L1 and area
gt 2.

Method 4 (M4): (All In, Ring-Spot Adjusted Spheres A): For each time bin (of
size At),

o= Kx Y Adj .SV SA,
Concentration = / where Adj, = defaV = " default where
Svdefault e SV4actual SA4actual

SA, . =(127-L,) x min[pxs, strbsz] x min[d,,,, ,do; ,]
and Adj, = 0 if either edge pixel is shaded (F; #0). Where
dye ,(mm) = (5.13(um ) x (L,)? x min[pxs, strbsz]? (zm?))/1000. and where K = unit

conversion factor. Also reject events for which L5 gt 2.1*L1 or L5 It 0.49*L1 and
area gt 2.

Counts time series: Simply plot the number of accepted particle events per time
bin.

T

o x K x > (Adj, x L x pxs x strbsz) ]
Extinction (Km™)= 2 2.(Adj. Ly v where K = unit
default

conversion factor. Reject events for which L4 gt 2.1*L1 or L4 1t 0.49*L1 and area
gt 2.

0.917 x K x D" (Adj, x % x (L7 X A PXS X StI’bSZ)S)

sV,

conversion factor. Reject events for which L4 gt 2.1*L1 or L4 1t 0.49*L1 and area
gt 2.

where K = unit

lefault

IWC: (g/m®) =

K x> (Adj, xzx(L7 x,/pXSXStI’bSZ)3) )
6 v where K = unit
default

conversion factor. Reject events for which L4 gt 2.1*L1 or L4 1t 0.49*L1 and area
gt 2.

LWC: (g/m®) =

Counts PSD: For each size bin, the formula for bin height is simply the number of
particles in that size bin. Use size bins with width equal to ,/pxs x strbsz for now.

Bin (L7 x |/ pxs xstrbsz) into the size bins. The first size bin has edges of 0.5*
Jpxs xstrbszand 1.5% /pxs = strbsz , the n™ size bin has (n - 0.5)* /pxs x strbsz and (n

+ 0.5)* |/ pxs x strbsz as bin edges.... Reject events for which L4 gt 2.1*L1 or L4 It

0.49*L1 and area gt 2. Do not adjust bin heights by multiplying by the ratio of total
events to accepted events.



Concentration PSD (#/L/um): For each size bin, the formula for bin height is
Kx > (Adj,) . . L
2 %in_wi dith(zm) x SV, where the sum is over all events in that size bin

and where K = unit conversion factor. Bin as above for counts PSD. Reject events
for which L4 gt 2.1*L1 or L4 It 0.49*L1 and area gt 2.

Area PSD (mm?/L/um): For each size bin, the formula for bin height is

%xKxZ(Adj4xL§xpxs><strbsz) )
(bin_ width(zm) x SV._.__.) where the sum is over all

events in that size bin and where K = unit conversion factor. Bin as above for
counts PSD. Reject events for which L4 gt 2.1*L1 or L4 1t 0.49*L1 and area gt 2.

Ice Mass PSD (g/m®/um): For each size bin, the formula for bin height is

0.917 x K x D" (Adj, x % X (L7 X A/ PXS x strbsz)3)/
(

bin_ width(zm) x SV.,.....) where K = unit

conversion factor. Reject events for which L4 gt 2.1*L1 or L4 It 0.49*L1 and area
gt 2.

Liquid Mass PSD (g/m®/um):
K x> (Adj, x % X (L7 X 4 PXS x strbsz)3)
(bin_ width(zm) x SV o)

conversion factor. Reject events for which L4 gt 2.1*L1 or L4 1t 0.49*L1 and area
gt 2.

where K = unit

Method 5 (M5): (All In, Ring-Spot Adjusted Spheres B): The same as Method 4
above except replace all L7 with Lg.

Method 6 (M6): (in focus only, combined): This method is for when there are
sufficient particles to use in focus only and when there is need to extend to larger
sizes than can be adequately sampled by ‘all in’ techniques. It uses M2 in-focus-
only after CleanAll for sizes smaller than 265. It uses M1 in-focus-only without
cleaning for sizes greater than 325. For sizes between 265 and 325, it uses the
average of the preceding two methods. A future improvement should be to replace
the M1 part with a reconstruction technique.




Appendix B: Removing Spurious HVPS Events

HVPS raw data include spurious effects. These are primarily from
instrument noise and from splashing of precipitation. Algorithms used to
clean the data of the majority of these spurious effects while retaining the
majority of the valid images are described here.

There are 5 quasi independent steps to the algorithm implemented via two
loops through the data:

First Loop:

1) Test for roundness.

2) Test for splashing events based on black and white area considerations.
3) Test for noise via line and dot patterns.

4) Test for noise via statistics of particle center locations.

Second Loop:

5) Test for splashing events based on inter-event-distances if the probe is
in precipitation.

Each step will be described in detail after defining terms:

Four measures of image length are shown in figure A.1. ‘L;’ is the number of
slices (pixels in the direction of travel) for which the event lasted. ‘L’ is the
number of shaded diodes (pixels in the direction along the array) for the slice for
which the same quantity is maximized. 'L4' is the number of diodes between, and
including the shaded end diodes, for the slice that maximizes the same quantity. 'Ls'
is the distance between (and including) the shaded end diodes considering all of the
slices together.

Other size parameters are a corrected size for out of focus images based on
Korolev’s work (L7), the number of shaded pixels for the entire image (summed
over all slices) (A;s) and an estimate of total number of pixels, shaded or not, for the
entire image (A;). The algorithm for A; is part of the Korolev size correction
method.



o
]
U‘l_

— .

I_ L1_|

Figure A.1: Two example particle images designed to
demonstrate the four measures of image size described in
the text.

1. Animage is determined to be round if L; 2 0.5 X Ls and Ls =2 0.5 x L;.
If an image is not round, it is rejected. An exception is made for the
very large images that do not fit within the array. If Ls >50 (500 um)
then an image is determined to be round if L; 2 0.5 x Ls. I. E. an

image is determined to be round if L; 20.5 x Ls and (Ls 2 0.5 x L, or
Ls > 50).

2. The larger a valid image is the greater the percentage of shaded
pixels. Splash effects often create large images that have lower
percentages of shaded pixels than valid images. The follow criteria
are used to eliminate such spurious images. If any of these five
criteria are met the image is rejected.

e (L5>100rL1>10)and (At>3.0 X As)
e (L5>150rL1>15)and (At>2.5 X As)
e (L5>20o0rL1>20)and (At>2.0 X As)



e (L5>350rL1>35)and (At> 1.5 X As)
e (L5>2.2XL7)and (L1>10.0)

3. Figure B.2 shows some examples of noise generated images
appearing in line plus dot patterns.

Figure B.2: Examples of line plus dot patterns caused by noisy
diodes.

These are eliminated using the following criteria:
i. (L1=As) and (L2=1) and (L1> 4)
ii. (As<1.35 XL1)and (L4=L5)and (L1 >4)and (L2 = 2)
iii. (L1>10)and (L1>0.75 X As) and (L1 <1.5 X As)
iv. (L4=L5) and (At> 0.9 X L1X L5) and (L2= 2) and (L2 # L4)
V. (L4=L5) and (At> 3.0 X As) and (L2= 2)
vi. (L4=L5) and (At> 4.0 X As)

If any of these six criteria are met the image is rejected.

4. The final step, of this first cleaning loop, is another noisy diode
removal method, based on the statistics of image center locations
calculated over 4000 images approximately centered on the image
being evaluated. When a diode is noisy there are more image
centers located on that diode than are located on quiet diodes. A
diode is labeled bad when it has more particle center locations than

the threshold value (TH = max(M + 5 x NIV 1.5)). Where M is the

mean number of image centers per diode across the array, for diodes
having more than a minimum number of image center counts.



images centered on this diode
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This minimum number is Mt —3x+/Mt , where Mt is the mean number
of image centers per diode across the array, for all diodes. If less
than 33 diodes satisfy the requirement of having more than Mt counts
then M is calculated from all diodes. Mt and M are recalculated after
bad diodes are identified, ignoring those diodes, and the process
repeated until no diodes exceed the threshold. An image whose
center falls on a bad diode is rejected unless it meets one of the
following criteria:

i. (L1=215)and (L5 2 15) and (As > 0.7 X At)

i. (L1=4)and (L5=4)and (As=0.5XAt)and (L2 >0.25
X L5) and (L1 < 50)

iii. (L2 =L4)and (L2 =L5)and (L2 22) and (As = 0.5 X At)

Figure B.3 shows an example of noisy diode data and the distribution
of image centers across the array.
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Figure A.3: Shows an example of noisy diode data intermixed with good particle
data. The images highlighted in yellow are rejected. Labels in red point to images
centered on diodes determined to be bad (too noisy) by the criteria described in the
text and exemplified in the particle center location distribution shown above.

1. This final step is another loop through the data but is applied only if
the current precipitation status is ‘yes’. The current precipitation
status is ‘yes’ if there is one or more particle(s) with L7 gt 100
microns in the 10000 particles, accepted by the previous 4 cleaning
steps, centered approximately on the current particle. It is
approximately centered because the precipitation status is updated
only every 100 particles?, instead of for every particle, to improve
speed. Another parameter, the current mean inter-particle time
(aveW8), is similarly updated every 100 particles' and calculated as
the average inter-particle time between the 10000 images, accepted
by the previous 4 cleaning steps, centered approximately on the
current particle. All the particles in the previous second are used
instead of 5000 particles if there are less than 5000 particles in the
previous second, similarly for the following 5000 particles or second.
If aveW8 > 40000 then C; = 2000 and C, = 8000. If aveW8 < 40000
then C;=0.05 X aveW8 and C,= 0.2 X aveW8. A patrticle is rejected
if the precipitation status is ‘yes’ and either: a) the particle’s inter-
particle time or the following particle’s inter-particle time is less than
Cy or b) both the particle’s inter-particle time and the following

! The precipitation status and current mean waiting time are updated every particle, instead of

every 100, if the valid particle rate is slower than 1000 per second, averaged over the surrounding
0.2 seconds.



particle’s inter-particle time are less than C,. Finally, a variable, adjo,
is calculated for each image. It is O for rejected images, 1 for
accepted images if precipitation status is ‘no’. When precipitation
status is ‘yes’, then for accepted images, we calculate a new true
average inter-particle time (TaW) = the average inter-particle time of
particles accepted by all the steps minus C;. Then calculate

_ _ . 2
k =1—p2C/TaW | o-2C/TaW (1_e CZITaW)

k is limited to a maximum of 0.9 and then adj, :ﬁ. adjo is used

elsewhere, in the algorithms for calculating concentrations etc., to
increase the weight of each accepted particle to account for those
good particles rejected by the inter-particle time criteria.

k is the fraction of events eliminated by the criteria given a true

waiting time distribution with mean of Taw. 1-e %' ™Wis the

probability of, or fraction of events with, inter-arrival times less than

C.. 1—e 2™ is the fraction of events eliminated due to the first

C,/TaW

criteria, leaving e’ not eliminated by the first criteria. Of

. - 2 . .
those, a fraction (1—e CZ’TaW) are eliminated by the second criteria.



